Principes de base CATIA V5- Lecon 2 : Création de contours

Guide de I'étudiant

Création de contours

Dans cette lecon vous apprendrez a créer une piece simple.

Sujet traites :
= Etude de cas : Création de contours
&= Obijectif de la conception
= Etapes du processus
= Création d'une nouvelle piéce
= Sélection d'un support d'esquisse approprié
= Création d'une géomeétrie esquissée
= Contrainte appliquée a une esquisse
= Création d'extrusions
@ Enregistrement et fermeture du document
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Etude de cas : Création de contours

Nous prendrons comme étude de cas pour cette lecon la plaque de support utilisée dans
I'assemblage de la perceuse a colonne représentée ci-dessous. La plaque de support est
une partie du sous-assemblage Drill support (support mandrin). Cette étude de cas se
focalise sur la création d'un contour en intégrant I'objectif de conception de la piece.

i | Fartl
L7 nilane
L7 2 alane
<7 = plane

=—8% Fartbody
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Objectif de la conception

La plague de support doit correspondre aux pré-requis de
I'objectif de conception suivants :

v Le modéle doit étre créé comme un 43 Parlt
composant unique. £y plane
' H : <7 e plane
= Ce n'est pas une pratique courante mais, dans o ol
ce cas, c'est un pré-requis. B peray
v Le trou central doit rester au centre du -_@%am
support. &7, Sketch 1

= Vous pouvez répondre a ce pré-requis en
créant un contour rectangulaire symétrique par
rapport a I'origine de la piéce et en

120

positionnant le centre du cercle (représentant
le trou) a l'origine.

v Les petits trous doivent étre a 30 mm du trou
central.
= Si vous contraignez la position des trois petits
trous sur un cercle de construction de 60 mm
de diametre, vous pouvez étre sdr de répondre
a ce pré-requis.
v" Le modéle doit étre enregistré sous le nom
Support_Plaque.

120

Guide de I'étudiant
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Etapes du processus

Vous suivrez les étapes suivantes pour créer la piece Support

Plaque :

1.
2.

o 0k W

Création d'une piéce.

Sélection d'un support d'esquisse
approprié.

Création d'une géométrie esquissée.
Contrainte appliquée a l'esquisse.
Création de l'extrusion.

Enregistrement et fermeture du
document.

Guide de I'étudiant
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Création d'une nouvelle piece

Dans cette section vous apprendrez a créer un fichier piece.

Suivez ces étapes :

1. Création d'une piéece.
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Création d'une nouvelle piéce

Lors de la création d'un nouveau modeéle,
I'atelier Part Design est activé.
L'enregistrement de la piece s'effectue avec
I'extension .CATPart pour la distinguer
d'autres documents CATIA.

Suivez ces étapes pour créer un fichier piece :

1. Utilisez I'une des ces méthodes :

a. Cliquez sur Démarrer > Conception
mécanique > Part design.

b. Sélectionnez le menu File > New (Fichier >
Nouveau) et sélectionnez Part dans la boite
de dialogue New (Nouveau).

c. Cliquez sur l'icbne Nouveau de la barre
d'outils Standard, puis sélectionnez Part dans
la boite de dialogue New (Nouveau).

2. Spécifiez un nom pour la piéce.

3. Cliquez sur OK. @

®

[R]CATIA V5 - [Fartl]
BIEE E- Edt Yiew lnsat Jook  Window  Hep

Infemstncturs > |

» Bt Part Design

Shape b BB Loemby Design
Analyss % S mulaion v Skelcaer
AEZPoant 3 ‘{f}: Pracust Functionsl Tossncirg & Annctation
M Mznufacturing b £ Gensrative Biw Festeners
‘Qigital bckup ¥ = Mold ~coing Design

J e Chrl+H
@ Mew from... @
[=F open. .. Chr
Close
—

Standard

B
% B@ oo

Pour garantir le respect des normes d'entreprise lors de la conception d'un OO it Vew  Insert
nouveau modeéle, vous pouvez également démarrer un nouveau modele a [ ew...

partir d'un modeéle existant déja conforme a ces normes :

";ﬁ Mew From...

Tools Windo

Chrl+M

Guide de I'étudiant
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Atelier Part Design

Une nouvelle piéce contient uniquement trois plans de référence par défaut : ce sont toujours
les premiers éléments de I'arbre des spécifications et ils servent de base pour la création des
composants.

[#]CATIA V5 - [Part1] = [=1 E3
EJ Stat  File  Edit Miew Inset  Tools  Window  Help =151
o |Partl o
27 Wy plane
#= vz plane
=7 zx plane
% Barfody

g

LlgpodpausanliEglsLle

NEEs8iEas R s BAE 2.,
Select an object or a command | =A| | L6 | |
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Sélection d'un support d'esquisse approprié

Dans cette section vous découvrirez le réle du support d'esquisse et apprendrez a
sélectionner le support approprieé.

Suivez ces étapes :

v
2. Sélection d'un support

d'esquisse approprié

Guide de I'étudiant
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Plans de référence

3] partl

Les plans de référence par défaut sont les trois e
premiers composants de chaque fichier piéce. £7 % rlare ‘ @
Leurs noms découlent des plans auxquels ils sont — .7 YE panse X @
paralleles, par rapport au systeme de — 7 7¢ pane
coordonnées de la piece :
A. plan XY PartRody
B. planYZ
C. plan ZX
Partl -
27y plane
Les plans de référence fournissent le support £ vz plane
i€ [ réée.
sur lequel la premiere esquisse est créée £ 7 plane
;- FartBody
#-[\ sketch.1

Contour esquissé sur le plan ZX.
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Réle d'une esquisse

Chaque nouvelle piece démarre par un
contour 2D, qui peut étre créé avec l'atelier
Sketcher.

L'atelier Sketcher est un atelier de travail en
2D. Les éléments créés dans Sketcher sont
exclusivement des éléments FILAIRES 2D.

Dans l'atelier Part Design, la géométrie créee
dans Sketcher est affichée sous la forme
d'une seule entité. C'est cette esquisse qui
est utilisée pour créer des éléments 3D dans
I'atelier Part Design.

Les esquisses sont contraintes de fagon a
pouvoir étre modifiées rapidement par simple
modification des cotes.

Guide de I'étudiant
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Support d'esquisse (1/2)

rSupport d'esquisse
Un support d'esquisse est un plan sur lequel
I'esquisse est créée. P
Le support d'esquisse doit étre planaire.
Esquisse

Vous pouvez créer une esquisse sur un plan
de référence ou une face plane de n'importe
quelle géométrie existante.

Le premier élément du modéle est créé
généralement sur I'un des plans de référence
par défaut.

Les esquisses
peuvent étre
extrudées pour
créer la géométrie
du solide.
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Support d'esquisse (2/2)

L'orientation par défaut du modéle dépend du
plan de référence sélectionné pour le support

d'esquisse. Contour
esquissé sur le

plan XY.
Le plan YZ est considéré comme étant la vue
de face de la piéce, comme défini par les
vues rapides (voir Lecon 1).

Lors de la sélection d'esquisse, pensez a

I'orientation du contour que vous créez. Contour

esquissé sur le
plan YZ.

Par exemple, vous sélectionnerez un plan

d'esquisse différent pour créer un contour

latéral, opposé a un contour de face pour la

géométrie 3D.

Contour
esquissé sur le
plan ZX.

2-12



Principes de base CATIA V5- Lecon 2 : Création de contours

Création d'une géometrie esquissée

Dans cette section vous apprendrez a accéder a l'atelier Sketcher et vous créerez une
géomeétrie esquissée.

Suivez ces étapes :

v
v

3. Création d'une géométrie

esquissée.

Guide de I'étudiant
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Création d'esquisses de base

Les contours esquissés sont créés dans l'atelier
Sketcher. Suivez ces étapes pour accéder a
I'atelier Sketcher a partir d'un autre atelier :

1. Sélectionnez un support d'esquisse planaire.

2. Cliquez sur l'icone Sketcher a partir de =
n'importe quel atelier ou il est possible de créer @@
une esquisse (par exemple, I'atelier Part 4
Design), ou cliquez sur Démarrer >
Conception mécanique > Sketcher. M

3. CATIA ouvre l'atelier Sketcher. %

227wy plane
7 y2 plane
2 24 plane

T_<'\4O<\b<®¢Ia{g}E§!;%¢!gH< {j}ﬁ{EX

&

DERsyeao R Ko BEel nTe 2,
obi nd I =]

Selest an obisct o a commar
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Etape 3 - Création d'une géométrie esquissée

Création d'esquisses positionnées

Les esquisses positionnées sont créées dans l'atelier
Sketcher. Suivez les étapes suivantes pour accéder a
I'atelier Sketcher a partir d'un autre atelier :

1. Cliquez sur l'icéne Esquisse positionnée a partir de
n'importe quel atelier ou il est possible de créer une
esquisse (par exemple, l'atelier Part Design).

2. Lafenétre Sketch positioning (Positionnement de
I'esquisse) apparait.

a. L'esquisse est positionnée par rapport au plan de référence.

b. L'origine de I'esquisse est positionnée en fonction de la
référence de l'origine.

c. L'orientation de I'esquisse est définie en fonction du type
d'orientation.

d. Il est possible d'affiner I'orientation de I'esquisse a I'aide des
boutons d'option.

3. CATIA ouvre l'atelier Sketcher.

Il est possible de modifier le support en ouvrant le menu
contextuel de I'esquisse (objet Esquisse.x > Nouveau support
d'esquisse). L'édition du support d'esquisse ouvre la méme
boite de dialogue dans laquelle il est possible de modifier les
parametres.

Les avantages de l'utilisation d'une esquisse positionnée
seront détaillés ultérieurement.

L@

[
e ©

®

® ® ©

Guide de I'étudiant
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Atelier Sketcher

L'atelier Sketcher est un environnement congu
pour faciliter la création des contours 2D. Ci-
dessous les éléments clés de I'atelier : [RITATIA V- Pan]

B Stet Fie Edt View lnset Tools window Help
3 Paitt

2w plane

. y2 plane:

. 2x plane

. . . s . #-303 PartBody
A. La grille, qui vous guide pendant la création 5

de contours. | Sy S L
B. La barre d'outils Contour, utilisée pour créer la AR R

géomeétrie.

C. La barre d'outils Contrainte, utilisée pour coter
et contraindre votre esquisse.

D. La barre d'outils Sketch Tools (Outils
d'esquisse), barre d'outils flottante (par
défaut) qui affiche les options disponibles lors @
de la création d'une géométrie. Les options de
cette barre d'outils varient en fonction de la
géomeétrie en cours de création.

]

]
s -NDREODE WA gl 2 L & *EE

\(’—N
|

NEEalEan R e B nme 2,
Select an object or a command | L=Rj R
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Grille

Par défaut une grille est appliquée au fond
d'écran de l'atelier Sketcher. Cette grille aide a
définir I'échelle des entités esquissées.

Lors de la création d'une esquisse, le pointeur
de la souris obéit aux points aimantés de la
grille. Cette fonctionnalité peut étre désactivée
temporairement en désactivant I'icéne Points
aimantés.

Les options de la grille peuvent étre configurées
a partir du menu Outils > Options >
Conception mécanique > Sketcher.

Vous pouvez :

A. Activer l'affichage de la grille.

B. Activer/désactiver I'option Points aimantés.

C. Modifier les valeurs de I'espacement
principal et des subdivisions.

Sketch tools

Points aimantés
désactivés

Points aimantés
activés

“-arid ( A)
"'E" ﬁ A Display
: 9 d Snap ko poink

[ llow Distortions

- Espacement princi:pah-

Primary spacing :

N
© .
Graduations : *"17TTTT [

H:rm

|10

v: | 100mm

OC e PO ACOC OIC S0 3% iy i Yoo IO A DG

TN
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Création de la géométrie

La géométrie esquissée est créée au moyen des
outils disponibles dans la barre d'outils Contour :

4

© el

Contours personnalisés
Contours prédéfinis
Cercles

Courbes

Ellipses et paraboles
Droites

Axes

Points

4\ 40 4-8_) 4

TETMOO®R

@EOOOOEE

L |

La barre d'outils Opération peut étre utilisée
pour modifier la géométrie esquissée existante.
Dans cette legcon vous apprendrez a vous
servir des outils de relimitation suivants :

I. Coins
J. Chanfreins

©0O
‘\’\Wl

-
A
I

1““ L
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Points

Icone

Description

Points par .
clic

Créez un point en cliquant sur I'esquisse.

Point avec _n
coordonnées &

Créez un point en définissant ses coordonnées dans
I'espace 2D de l'esquisse.

Points
équidistants

o

Créez autant de points équidistants que vous le
souhaitez sur une courbe existante. Une fois les points
crees, ils sont considérés comme des entités séparées.

Point par ~u
intersection

A

Créez le point d'intersection entre deux courbes
existantes.

Point par 1
projection =

Projetez un point existant sur une courbe existante. La
projection peut étre perpendiculaire a la courbe ou suivre
une direction.

Guide de I'étudiant
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Droites
Icone Géométrie | Description
Droite yd - Créez une droite en cliquant sur deux points pour
-+ définir ses extrémités.
Droite S o Créez une droite infinie en cliquant sur deux
infinie points pour définir sa direction.
Droite Lo . Créez une droite tangente a deux courbes
i 2 s .
bitangente TN, existantes.
Droite ?Ef—l Créez une droite bissectrice a deux droites
bissectrice existantes.
Droite E i Créez une droite perpendiculaire a une courbe
perpendicul 2. -~ | existante. Créez une droite en sélectionnant une
aire extrémité et la courbe a laquelle la droite sera
aune perpendiculaire.
courbe
L ; ;'- FartBody

Un élément de Sketcher est basé sur des points. &g 1

Par conséquent, chaque fois que vous créez une #-4 Absoluteis

géométrie dans l'atelier Sketcher, des points sont =I=’G.5 Geometry

créés implicitement. La géométrie esquissée est / Line.1

ajoutée a I'arbre des spécifications sous la = Point.1

branche Geometry (Géométrie) de I'esquisse. = Paint.2

Guide de I'étudiant
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Cercles
Icone Géométrie Description
Cercle (+) I Créez un cercle en définissant son

\ centre et son rayon.

Cercle par trois (% \‘d N Créez un cercle passant par trois
points ) NIV points.
Cercle £ TN Créez un cercle, en définissant les
par - \ coordonnées de son centre par rapport
coordonnées " a l'esquisse d'origine et son rayon.
Cercle @j Créez un cercle tangent a trois courbes
tritangent o existantes.

Arc par trois (s - Créez un arc passant par trois points,

points LR relimité par les premier et dernier points
sélectionnés.

Arc par trois points @ r *\r Créez un arc passant par trois points,

en commengant par Nl relimité par les premier et deuxieme

ses limites points sélectionneés.

Arc - ~ X Créez un arc défini par son centre et les
deux points limites.

Guide de I'étudiant
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Ellipse, Parabole, Hyperbole et courbe spline

souhaitez.

Icone Géométrie Description
Ellipse = Créez une ellipse, en
_43_ séllec.t?onnant son centre et en
spécifiant ensuite ses deux
@ @ @ diametres par clic sur deux points.
Parabole  \3} Créez une parabole, en sélectionnant :
par foyer & \& Q‘#} K + son foyer
" - son sommet
@ @ @ @ * les points la relimitant (points limites)
Hyperbole .= , Créez une hyperbole par sélection :
par foyer b L LL/ L% t * de ses foyer et points de centre
e T e o e son sommet
@@ @ @ @ + les points la relimitant (points limites)
Courbe Créez une courbe en passant par
spline 2 +- /+ AN- /\f autant de points que v%us le i
® ®

Terminez la courbe en double-
cliquant.

Guide de I'étudiant
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Coniques
Une fois l'icone Conique sélectionnée, plusieurs outils
s'affichent dans la barres d'outils Outils d'esquisse qui
~ contrél,ent sa ,création.
Icone Géométrie Description
Conique par A P Créez en sélectionnant :
deux points * un point limite et définissez sa tangence

avec premier et
second points
limites

/\\®
JoSNO

 l'autre point limite et définissez sa
tangence

* un point de passage

Conique par /Ay
deux points par
intersection des
tangentes

Créez en sélectionnant :
» deux points limites

+ un point définissant l'intersection des
tangentes

* un point de passage

Conique par quatre i
points avec une

Créez en sélectionnant :
+ deux points limites

tangence - @ » deux points de passage et définissez une
1 tangence sur le premier et le dernier point

Conique par A Créez en sélectionnant :

cing points 6 0  deux points limites

+ trois points de passage

Guide de I'étudiant
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Profils prédéfinis (1/2)

Icéne Géomeétrie Description
Rectangle [ ] ® ® Créez un rectangle en cliquant sur les
_43_ deux sommets Opposés.
Rectangle > ® 6 Créez un rectangle en définissant
orienté _43_ /E}%@ deux sommets consécutifs pour
indiquer sa direction, puis un troisieme
pour lui attribuer une largeur.
Parallélo- E:I @ @ ' @ Créez un parallélogramme en définissant
gramme ' —43— deux sommets consécutifs, un troisieme
pour spécifier sa largeur et son angle.
Contour s |®O @ & ® . Créez un contour oblong en
oblong & = _43_ L définissant un segment comme axe,
3 et en définissant son épaisseur.
Contour Créez un contour oblong en arc en

oblong en arc

définissant un arc comme axe et la
largeur du contour.

Guide de I'étudiant
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Profils prédéfinis (2/2)

Icone Géomeétrie

Description

Trou de Q ® @

config.

serrure Jo{r'_ | +
Selon /’

Créez un contour Trou de serrure en
définissant le centre et le rayon du
grand cercle, le centre et le rayon du
petit cercle.

Hexagone {;} ®

Selon _q}_
config.

Créez un hexagone en définissant le
centre et un point de I'nexagone.

Rectangle =]
centré @

Créez un rectangle centré en
définissant son centre et 2 points pour
spécifier sa hauteur et sa largeur.

Parallélogram &l
me centré

Une fois les contours prédéfinis
créés ils sont divisés en éléments.
Par exemple, un rectangle est divisé
en quatre droites et quatre points
(les sommets).

Créez un parallélogramme centré en
sélectionnant la 1re droite, puis la 2e,
et en cliquant pour définir ses
dimensions. Le parallélogramme est
centré sur l'intersection des deux
droites. Ses arétes sont paralleles aux
droites sélectionnées.

Guide de I'étudiant
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Contours définis par l'utilisateur

Suivez ces étapes pour créer un contour :

Etape Géométrie Description
1. Démarrer : Le contour peut étre commencé
le contour. ﬂ avec un segment en utilisant
Q_E. Q) D > e I'option Droite, ou avec un arc
Droite Arc par trofs points via l'option Arc par trois points.
2. Continuer Vous pouvez continuer le
le contour. contour en utilisant les
segments (option Droite), les
arcs tangents (Arc tangent)
A
OO_O OO CC> _ ou les arcs non tangents (Arc
Droite Arc tangent Arc par trois points par trois points).
3. Terminer Terminez un contour fermé en
le contour. sélectionnant le premier point.

NS

Terminez un contour ouvert en

double-cliquant sur le dernier point.

Guide de I'étudiant
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Présentation des relimitations

Icone Géométrie Description
Coin ~ _— | Créez une forme arrondie entre les
/—’/ deux droites sélectionnées.
!
Chanfrein Créez un chanfrein entre les deux

o

droites sélectionnées.

Guide de I'étudiant
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Géomeétrie de construction

|

|
La géométrie de construction est créée dans | /r
une esquisse pour vous assister dans la I
création d'un contour. Contrairement a une |
géomeétrie esquissée standard, la géométrie de !
construction n'apparait pas a I'extérieur de I L NS
I'atelier Sketcher.

Un élément esquissé est créé en tant
qu'élément de construction quand l'icbne | I
Eléments standard/Eléments de = =
construction (dans la barre d'outils Sketch

tools (Outils d'esquisse)) est mise en

Géométrie de
construction

surbrillance. La création de la géométrie de Sketch tools B
construction obéit aux mémes techniques que | o R ‘ O

la géométrie standard esquissée, et elle s'en —

distingue car elle apparait en pointillés. Dans cet exemple, la construction

de formes symétriques a été
assistée par l'utilisation de la
géométrie de construction.
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Recommandations sur la création d'esquisses

Dans cette section, vous découvrirez des recommandations qui peuvent vous aider lors
de la création d'esquisses.
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Réle d'une esquisse positionnée (1/4)

L'utilisation d'une esquisse positionnée est recommandée
pour la création d'un profil esquisseé.

1. Elle permet de définir de fagon explicite I'origine et
l'orientation de l'esquisse.

a. Sélectionnez la face ; la position de I'origine est

Implicit (Implicite)
b. Sélectionnez le type d'origine — Intersection 2

lines (Intersection de 2 lignes)
c. Sélectionnez les données de référence — les 2

arétes de la face biseautée

Sketch Positioning HE
— Sketch Fositioning
Type: Positioned j

Feference|Pad.1/Face.1

Crigin
<1 b> Type: Intersection 2 lines j

Feference (Pad.1/Edge.]
Fad.1/Edge.2
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Réle d'une esquisse positionnée (2/4)

2. Vous pouvez gérer 'orientation de I'esquisse
lorsque vous ouvrez l'atelier Sketcher.

a. Sélectionnez Swap (Intervertir) pour inverser
les axes HetV

b. Sélectionnez Reverse V (Inverser V) pour
inverser cet axe

c. Cliquez sur OK pour ouvrir I'atelier Sketcher et
visualiser I'orientation voulue

Guide de I'étudiant
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Réle d'une esquisse positionnée (3/4)

Les éléments de I'esquisse sont positionnés par rapport
aux axes de I'esquisse plutot qu'aux éléments qui sont
extérieurs a l'esquisse. La stabilité du profil d'esquisse
est ainsi garantie en cas de modification du support
d'esquisse.

Positioned_Sketch

1. Dans I'exemple ci-contre, deux esquisses sont

superposées.
a. Laligne en pointillés verts indique I'esquisse # sketch 3
positionnée (Sketch.2) dont l'origine se trouve #-5/\ sketch.2

dans le coin inférieur de la face biseautée.

b. La ligne pleine bleue indique 'esquisse (Sketch.3)
dont I'origine se trouve sur I'aréte de la face
biseautée.

2. La hauteur de la paroi verticale droite est réduite et la Pesitoned_Sketeh

face biseautée est modifiée ol
i W2 plane
......... 7 plane
, . . . R
a. L'esquisse positionnée (Sketch.2) reste "f%rm
po.s[tlonne\e correctement par rapport a son +—@Sketch.3
origine et a la face # 5/ Sketch.2

b. L'esquisse (Sketch.3) reste positionnée
correctement par rapport a son origine MAIS
glissera sur la face biseautée

Guide de I'étudiant
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Réle d'une esquisse positionnée (4/4)

Pour repositionner plus facilement I'esquisse par
rapport a une autre référence, il est nécessaire de
redéfinir la face de référence et le type d'origine.

Sketch Positioning

—aketch Fositionirg

Type: Posrcned =]
Felereicelrad 1 ace ]

—igir
Tvpe: Intersection 2 lines j
Fetereice]Pad 1/Edge
Fad1/Cdge.2
—ianEich
Type Implicit j

RFetereace]rc Scloctoq

@ H Jireciion O % Jirection

[ Neverse H [ Reverse ' [ Swop

2 towve geometny

g e @ Cancal |
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Création d'un contour : les meilleurs outils a utiliser

Lors de la création d'un profil esquissé, vous pouvez

utiliser plusieurs outils. ah L1 & 2 O

Deux questions sont souvent posées :

* Quels sont les meilleurs outils a utiliser ?
« Jusqu'a quel degré de complexité mener une esquisse ?

Il est souvent plus efficace de créer la forme avec
I'outil Contour (ou les outils Contour prédéfini).

Pensez a utiliser des points séparés ou uniquement
des droites lorsque vous avez besoin de terminer ou
modifier une forme.

Vous pouvez créer
des droites
individualisées, puis
utiliser I'outil de
relimitation pour
créer la forme
requise :

Guide de I'étudiant
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Quand utiliser un congé, un chanfrein, une dépouille ? (1/2)

Il est déconseillé d'utiliser des congés, des
chanfreins et des dépouilles lors de la création d'un
profil esquissé, car certains des procédés de
fabrication doivent supprimer les composants
d'habillage.

A. Créez une esquisse simple, ajoutez ensuite les
arrondis et les chanfreins : les modifications
sont plus longues, mais les arrondis et les
chanfreins peuvent étre réorganisés,
désactivés ou supprimés, si nécessaire.

®

.

*Ii’ Pa@odv

s jPad.l
& Sketch. 1
—F5) EdgeFillet.1 |

—¢ 4 Chamfer.1

_H}E!‘ J Chamfer.2

—3 EdgeFillet.2 |
—54 EdgeFillet.3 |

Guide de I'étudiant

2-35



Principes de base CATIA V5- Lecon 2 : Création de contours

Quand utiliser un congé, un chanfrein, une dépouille ? (2/2)

B. Faites la distinction entre un rayon mécanique
et un rayon de style. Un rayon mécanique vise
a supprimer les coins vifs alors qu'un rayon de
style répond a un besoin fonctionnel/de style. ©
Un rayon de style peut étre inclus dans la
définition du profil.

® “pe——

L4
R 32
v
vo
v
R 75
% [+) H xio H§§< 050
R 10

R32 et R75 sont des rayons de style R12 et R8 sont des rayons de
alors que les deux rayons R10 sont style alors que les deux rayons
mécaniques. R5 sont mécaniques.

Guide de I'étudiant
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Exercice : Création de contours

Exercice : Recapitulatif

‘ 15 min

Dans cet exercice, vous créerez divers éléments géométriques dans l'atelier
Sketcher. Cet exercice vous aidera a comprendre les outils d'esquisse et a vous
familiariser avec cet atelier. Vous créerez des esquisses sans vous préoccuper de
contraintes. Cet exercice est accompagné d’instructions détaillées.

A la fin de cet exercice, vous serez capable de :

= Quvrir une nouvelle piece
= Accéder a l'atelier Sketcher

= Créer des droites, des contours prédéfinis, des contours personnalisés, des

chanfreins. -

= Fermer un fichier sans l'enregistrer.

Selon config.

!
D%I

o o ) e e et

@ doEdte \
foiia I,
AV L

Selon config.
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C'est a vous (1/9)

1. Création d'une piéce.
= Sélectionnez Part dans la boite de dialogue
New (Nouveau) pour créer un fichier piéce.
a. Cliguez sur Fichier > Nouveau.

b. Sélectionnez Part dans la boite de
dialogue New (Nouveau).

c. Cliquez sur OK.
d. Conservez le nom par défaut et cliquez sur ‘
OK.
2. Lancez I'atelier Sketcher.

= Les esquisses sont créées dans l'atelier
Sketcher. Vous pouvez 'ouvrir en

sélectionnant un support d'esquisse et i par
= piane <

en cliquant sur l'icbne Sketcher .

a. Sélectionnez le plan XY comme
support d'esquisse.

b. Cliquez sur l'icéne Sketcher.

3. Désactivation des contraintes automatiques.

=  Vous découvrirez les contraintes dans la section
suivante ; désactivez-les pour le moment.

a. Vérifiez que l'icbne Contrainte géomeétrique
n'est pas mise en surbrillance. Si c'est le cas,
cliguez dessus pour la désactiver.

b.  Vérifiez que l'icbne Contrainte dimensionnelle
n'est pas mise en surbrillance. Si c'est le
cas, cliquez dessus pour la désactiver.

®

=7 ¥z plane
2= zx plane
#-£53 PartBody

|

Assurez-vous que les icones
Contraintes géométriques et
Contraintes dimensionnelles ne sont
pas mises en surbrillance, comme
montré ci-dessus.

Guide de I'étudiant
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C'est a vous (2/9)

4. Créez un rectangle.
= Lapremiere forme est un rectangle. Créez |:|

I'esquisse en utilisant I'outil de contour

prédéfini pour les rectangles.

a. Cliquez sur l'icbne Rectangle dans la barre
d'outils Profile (Contour). et I S A

b.  Cliquez en un point de I'écran pour % --------- e T
positionner le sommet supérieur gauche du = 5 5 P
rectangle.

c. Faites glisser le curseur vers le bas puis
vers la droite, puis cliquez pour marquer | : : | :
I'emplacement du sommet inférieur droit du SRS IS A SRS S S
rectangle.

___________________________________________________

......................................................
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C'est a vous (3/9)

5. Création d'un chanfrein. /_

=  Un chanfrein est ajouté au contour avec l'outil :
de relimitaton. ——
a. Cliquez sur l'icone Chanfrein & partir de la Yf} _________ ]
barre d'outils Opération. Notez que la barre oo
d'outils Outils d'esquisse peut étre
développée pour afficher les outils
disponibles pour la création de chanfreins.

--------------------------------------------

Sélectionnez I'aréte gauche du rectangle. EEI S S S S
c.  Sélectionnez l'aréte supérieure du e G
rectangle. 5 \Q

d. Placez le chanfrein en faisant glisser le . oo
curseur vers la position que vous souhaitez, S R S
puis cliquez sur le bouton gauche de la : R
souris pour le positionner.

Guide de I'étudiant
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C'est a vous (4/9)

6. Création d'un cercle.
. Dessinez la forme suivante en utilisant
I'outil Cercle.

a. Cliquez sur l'icbne Cercle dans la
barre d'outils Contour.

b.  Cliquez sur un point de I'écran pour
définir le centre du cercle.

c. Faites glisser le curseur vers l'extérieur
pour définir le rayon du cercle et
cliguez avec le bouton gauche de la
souris pour le corriger.

7. Créez une droite.
. Dessinez une ligne horizontale a I'aide
de l'outil Droite.
a. Cliquez sur l'icbne Droite dans la
barre d'outils Contour.
b.  Cliquez sur un point de I'écran pour
définir le point de départ de la droite.

c. Faites glisser le curseur dans la
direction voulue et cliquez sur un autre
point pour définir la fin de la droite.

o

......................................

......................................................

Guide de I'étudiant
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C'est a vous (5/9)

8. Créez un contour Trou de serrure.

= Ajoutez un contour prédéfini Trou de (l}l
serrure avec l'outil Trou de serrure.

a. Cliquez sur l'icbéne Trou de serrure
dans la barre d'outils Contour.
Observez la barre de message et notez
gu'elle affiche les données d'entrée
dont vous avez besoin pour créer le
composant.

b.  Cliquez sur un point de I'écran pour
définir le centre du plus grand cercle.

c. Faites glisser le curseur vers le bas et
cliguez sur un autre point pour centre
du plus petit cercle.

d. Faites glisser le curseur

horizontalement vers I'extérieur pour
définir le rayon du plus petit cercle et
cliquez avec le bouton gauche de la
souris pour le corriger.

e. De nouveau, faites glisser le curseur
horizontalement vers I'extérieur pour
définir le rayon du plus grand cercle et
cliquez avec le bouton gauche de la
souris pour le corriger.

Guide de I'étudiant
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C'est a vous (6/9)

9. Créez un contour personnalisé.

Créez un contour défini par l'utilisateur
en utilisant I'outil Contour.

a.

Sketch tools @ %]

Cliquez sur l'icobne Contour dans la
barre d'outils Contour.

Notez que l'icone sélectionnée par
défaut dans la barre d'outils Sketch
tools (Outils d'esquisse) est Droite.
Cliquez en un point de I'écran pour
définir le point de départ de la droite.

Faites glisser le curseur et cliquez sur
un autre point pour définir la fin de la
droite.

Créez un arc tangent a la droite en
cliquant sur l'icébne Arc tangent.

Faites glisser le curseur pour définir le
rayon de l'arc et cliquez avec le
bouton gauche de la souris pour
terminer I'arc. Remarquez que la
barre d'outils de Contour se
transforme en barre d'outils par
défaut Droite.

----------------------------------------------------------------------

| %‘ o B rrj‘ ) 25 End Point: H: 288 883

W: [-22.222mm L: [232.007mm A [162.301deg

Guide de I'étudiant
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C'est a vous (7/9) T —_—

9. Créez un contour personnalisé (suite).

f. Créez une autre droite, comme illustré ci-
contre.

g. Fermezle contour en cliquant sur l'icbne
Arc par trois points.

h.  Cliguez sur un point (comme illustré) pour
définir le deuxiéme point de I'arc.

i. Cliquez sur le point de départ du contour
pour terminer I'arc. Remarquez que I'outil
Contour achéve le contour
automatiquement.

Sketch tools @ E

| %| Ao S8 t'¢| ) L) EndPoint: H: [258.883mm v. [22.222mm L: [232.007mm 4:[162.301deg
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C'est a vous (8/9)

10. Créez une droite de construction.

. Convertissez la géométrie existante en
éléments de construction en utilisant
l'outil EIéments standard/Eléments
de construction.

a. Sélectionnez les quatre segments du
contour (appuyez et maintenez
enfoncée la touche <Ctrl> pour
sélectionner plusieurs éléments).

b.  Cliquez sur l'icbne Eléments
standard/Eléments de construction
dans la barre d'outils Sketch tools
(Ouitils d'esquisse).

c.  Cliquez n'importe ou sur I'écran pour
désélectionner la géométrie.

d. Cliquez a nouveau l'icone Eléments
standard/Eléments de construction
pour désactiver l'outil.

A
|

o 5 s

e

a
| g el B9 o

Guide de I'étudiant
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C'est a vous (9/9)

11. Créez d'autres géométries.
. Essayez de créer les géométries
illustrées ci-dessous en utilisant les
outils appropriés.

12. Fermez I'esquisse.
a.  Cliquez sur Fichier > Fermer.

b.  Cliquez sur No (Non) pour fermer la
boite de d|aloque du message

AEmEann D

D

Selon config. | I

= Selon config.|

i —

Cloze

R,
SEemmenne
| X

\!:() Do you want bo zave the changes pou made to Part2 7

ez Ma | Cancel |

(1or)

Guide de I'étudiant

2-46



Principes de base CATIA V5- Lecon 2 : Création de contours

Récapitulatif de I'exercice : Création de contours

v Création d'un fichier piéce.

v Sélection du plan XY comme support
d'esquisse

v' Création d'une géométrie esquissée

v Fermeture du document sans
I'enregistrer

CQC—

D l
1

I

Selon conflg i

Selon config.
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Exercice : Création de contours

Exercice : Recapitulatif

‘ 15 min

Dans cet exercice, vous créerez un contour esquissé. Cet exercice est
accompagné d'instructions détaillées.

A la fin de cet exercice, vous serez capable de :
= Créer une piece

= Accéder a l'atelier Sketcher

= Créer une géométrie en utilisant I'outil de |7

contour

= Créer un arrondi

* Fermer le document sans I'enregistrer

Guide de I'étudiant
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C'est a vous !
1. Créez une nouvelle piece. @

2. Créez une esquisse positionnée en utilisant
le plan YZ comme plan de référence et
accédez a I'atelier Sketcher.

3. Veérifiez que les contraintes automatiques
(dans la barre d'outils Sketch tools /Outils

d'esquisse) sont désactivées. .
<etch tools k|

J

4. Créez le contour montré ci-contre en
utilisant I'icone Contour. 4

5. Créez I'arrondi. (C'est un type de style du
rayon).

6. Fermez le document sans I'enregistrer. @
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Récapitulatif de I'exercice : Création de contours

v Création d'un fichier piéce.

v Sélectionnez le plan YZ comme support
d'esquisse.

v Création d'une géométrie esquissée.

v" Fermer le document sans I'enregistrer

L'esquisse de cet exercice peut étre utilisée
pour créer un composant de révolution,
comme ci-dessus. Vous apprendrez a créer
des révolutions dans la Lecon 4.
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Exercice : Création de multi-contours

Exercice : Recapitulatif

‘ 10 min

Dans cet exercice, vous créerez un contour constitué de plusieurs formes.
Vous utiliserez les outils des exercices précédents pour mener a bien
l'exercice.

A la fin de cet exercice, vous serez capable de :
= Créer une piece

= Accéder a I'atelier Sketcher

= Créer une géométrie esquissée

* Fermer le document sans I'enregistrer

ATTENTION : pour simplifier I'exercice, I'esquisse contient plusieurs contours fermés représentant la forme
externe de la piece 3D (les congés) et les formes externes (les trous et les poches). D'une maniere générale,
pour les pieces complexes, il est préférable de simplifier les esquisses a I'aide de composants 3D dédiés (les
congeés, les chanfreins, les trous ou les dépouilles, par exemple)
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C'est a vous !

1. Créez le contour illustré ci-contre, en
utilisant le plan ZX comme support
d'esquisse.

/o

I
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Récapitulatif de I'exercice : Création de multi-contours

v Création d'un fichier piéce.

v Sélection du plan ZX comme support
d'esquisse.

v Création d'une géométrie esquissée.

v Fermeture du document sans
I'enregistrer.

Vous pouvez créer le contour extérieur de
plusieurs fagons :

= Créez le contour en utilisant une série de
droites et d'arcs.

= Créez la forme de base en utilisant I'outil
Contour, ajoutez ensuite des arrondis et
des chanfreins sous forme d'opérations
séparées.

= Créez le contour complet en utilisant I'outil
Contour.

Guide de I'étudiant
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Contrainte appliquée a une esquisse

Dans cette section, vous apprendrez a appliquer des contraintes a une esquisse en
utilisant des contraintes géométriques et dimensionnelles.

Suivez ces étapes :

v
v

v

4. Contrainte appliquée a
I'esquisse.

Guide de I'étudiant

2-54



Principes de base CATIA V5- Lecon 2 : Création de contours

Guide de I'étudiant

Création de contraintes sur l'esquisse

Une fois que vous avez créé la géométrie esquissée, vous
pouvez ajouter des contraintes dimensionnelles et ;
géometriques.

i

Les contraintes servent a fixer mathématiquement la
géométrie dans I'espace. Sans contraintes, la géométrie
peut étre déplacée au moyen de la souris. Si le contour
esquissé est déplacé, les solides qui sont pris en charge
par ces contraintes sont également déplacés. Dans le
contexte d'un assemblage, si une piece est déplacée, une
autre piece qui lui est reliée peut aussi étre déplacée. Déplacement de quatre
droites non contraintes
Sans contraintes, la création de composants peut devenir
imprévisible et les modifications d'un modele peuvent @
gravement affecter la forme et la fonction de tout
I'assemblage. Les contraintes sont utilisées pour relier
logiqguement de fagon spécifique un élément avec un
autre, ainsi qu'avec lui-méme.

Une fois les contraintes créées, elles peuvent étre H
modifiées en changeant leurs valeurs ou leurs positions.
Gréce a la facilité avec laquelle les contraintes peuvent
étre modifiées et a I'associativité descendante de CATIA
V5, l'utilisateur a la possibilité d'explorer des conceptions
alternatives tout en respectant l'objectif de conception.
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Contraintes géomeétriques et dimensionnelles

Des contraintes sont ajoutées a la géométrie
esquissée dans l'atelier Sketcher. Vous pouvez
ajouter deux types de contraintes a la géométrie
esquissée :

A. Contraintes géométriques, indiquant les
positions réciproques (et par rapport a la
géométrie 3D existante) des éléments
esquisseés.

Contrainte géométriq'ue
(ici concentricité)

B. Contraintes dimensionnelles, spécifiant la ,
distance entre deux éléments. Cette distance 5
peut étre linéaire, angulaire ou radiale, en _-%5
fonction du type d'éléments géométriques :
impliqués. . :

Ces contraintes peuvent étre définies en utilisant les |

icbnes a partir de la barre d'outils Contraintes :

Contrainte dimensionnelle

C. Contrainte définie dans une boite de dialogue (ici distance)

D. Contrainte

config.
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Esquisses entierement contraintes

Dans l'idéal, une esquisse finale doit étre
entierement contrainte. La taille et la position de
I'esquisse doivent étre clairement définies. Une
esquisse sous-contrainte peut empécher de
maintenir I'objectif de conception quand des
modifications sont appliquées au modéle.

Des esquisses contraintes vous permettent
d'utiliser pleinement les capacités associatives et
paramétriques de CATIA.

Le statut de contrainte d'une esquisse est indiqué
par sa couleur :

« Vertindique que I'esquisse est entierement
contrainte. La géométrie est fixe et ne peut pas
étre déplacée sans modifier les valeurs des
dimensions.

« Blanc indique que I'esquisse est sous-
contrainte. Il reste encore des degrés de liberté.

* Violet indique que I'esquisse est sur-contrainte.

* Rouge indique que les contraintes de I'esquisse
sont incohérentes. L'esquisse ne peut pas étre
mise a jour avec les contraintes actuelles.

L'esquisse pour la coupe
n'est pas contrainte. Une
fois les modifications sur
le solide appliquées, la
coupe n'est plus a la
bonne position.

L'esquisse pour la coupe
est entierement
contrainte. Une fois les
modifications sur le
solide appliquées, la
coupe est toujours dans
la bonne position.

Guide de I'étudiant
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Contraintes géomeétriques (1/2)

Représentation

Description

Fixité

=

Un élément fixe ne peut pas étre modifié.

Coincidence

Rend un point d'élément coincident avec un autre élément.

Concentricité ) ).
@

Rend deux arcs concentriques.

Tangence

Définit la continuité en tangence entre deux éléments.

Parallélisme

Rend deux droites paralleles. Sélectionnez d'abord la droite
fixe puis la droite qui lui sera paralléle.

Guide de I'étudiant
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Contraintes géomeétriques (2/2)

Représentation

Description

Perpendicularité

Rend deux droites perpendiculaires.

Horizontale Rend une droite horizontale (paralléle a I'axe H de
I'esquisse).

Verticale Rend une droite verticale (parallele a I'axe V de l'esquisse).

Symeétrie Rend deux droites symétriques par rapport a I'élément

sélectionné.

Sélectionnez d'abord les deux droites extérieures, puis
I'élément par rapport auquel elles seront symétriques.

Guide de I'étudiant
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Contraintes dimensionnelles

Représentation Description

Distance 7\ La distance entre deux éléements est calculée.
Longueur /‘\3 - La longueur de I'élément contraint est calculée.
Angle :L]“ Calcule I'angle entre deux droites non paralleles.

1012

Donne le rayon ou le diametre d'un cercle ou d'un
arc.

Rayon/Diametre

Q)

2-60



Principes de base CATIA V5- Lecon 2 : Création de contours

Guide de I'étudiant

Recommandations sur les contraintes

Dans cette section, vous découvrirez des recommandations qui peuvent vous aider lors
de l'application de contraintes a des esquisses.
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Esquisse en contexte (1/2)

Créer une esquisse en contexte signifie
utiliser une géométrie existante pour créer
une nouvelle géométrie. Lors de la
création d'esquisse, gardez toujours a
I'esprit votre objectif de conception en
fonction duquel vous dimensionnerez et
appliquerez des contraintes a votre
esquisse. Utilisez les éléments existants
du modele pour contraindre votre

Géométrie 3D utilisée
pour esquisser

esquisse courante. Par exemple, la poche @ et contraindre les

contours.

montrée ci-contre, doit rester a 15 mm du
c6té droit du composant de base. En
fixant la distance de I'esquisse par rapport
au co6té droit du composant de base, vous
pouvez maintenir cet objectif de
conception méme si les dimensions du
composant de base sont modifiées.
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Esquisse en contexte (2/2)

Il est déconseillé d'utiliser les composants d'habillage
pour une esquisse en contexte. En effet, certains des
procédés de fabrication doivent supprimer les
composants d'habillage et ces derniers sont plus
susceptibles d'étre réorganisés et désactivés.

1. Dans I'exemple ci-contre, Sketch.2 existe dans le
contexte de l'aréte de EdgeFillet.1.
a. Encas de désactivation ou de suppression de
EdgeFillet.1, Sketch.2 génere une erreur.

2. L'ordre de sélection par priorité d'un élément
existant pour une esquisse en contexte pourrait
étre le suivant :

a. Eléments fixes, comme les plans XY, YZ, ZX.
b. Un autre élément d'esquisse.

c. Laface d'un élément 3D.

A éviter -

d. L'aréte d'un élément 3D.

@@ Partl

... xy plane

...” yz plane

..~ zX plane

ii“{:l} PartBody

#-F)pad.1

|—\$EdgeFillet.1
@Hole.z
@HO|E.3

f’@HoleA
@Holej

#-5h sketch 2

& lparm

[ .7 % plane
[ ...’ ¥Z plane
[~ .7 2% plane
:r-ﬂ;ﬁpartsudy
7] rad 1
|_.{',ﬁ?l Edgerillet.L

[Tl Hok 2

Fr{Clvok.s
#-[ClHok 4
Fr{C]Hokes
t"npﬂsketch.z
i-—@(,‘eometrical set.1

ii"@ Geometrical Set.1 \@

Seckek. 2
Projecticn. 1

to Edge
ECg=.1 6 far=, anedge, of 3 vertex 15 no lorgar racognized.

Desctivate
L.

a0 need to ecik the sketch to sobee these problens,

2=l
=4t
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Orientation de I'esquisse (1/2)

Il est recommandé d'orienter I'écran parallélement au
plan d'esquisse dans lequel vous créez une géométrie
esquissée. Par défaut, cette orientation est
automatique. Quand vous sortez de I'atelier Sketcher,
I'écran reoprend automatiquement l'orientation 3D
précédente.

Par défaut, toutes les géométries en 3D sont
accessibles quand vous travaillez dans I'atelier
Sketcher. Cela signifie qu'il est possible de contraindre
la géométrie d'esquisse 2D avec des composants
n'appartenant pas a la méme esquisse ou au méme
plan d'esquisse.

Lorsque vous contraignez la géométrie esquissée avec
des éléments 3D existants, il est judicieux de faire
pivoter le modele dans une vue 3D. Ce faisant, vous
vous assurez que le bon élément 3D est sélectionné.
Une fois I'élément 3D mis en surbrillance, sélectionnez
I'icéne Vue normale pour retrouver I'orientation
paralléle au plan d'esquisse.

Guide de I'étudiant
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Orientation de I'esquisse (2/2)

Lorsque vous contraignez l'aréte de la piece,
si vous affichez I'esquisse en vue normale,
CATIA crée la contrainte pour la premiere
aréte. Il vaudrait mieux faire pivoter lI'esquisse
et sélectionner un composant plus stable (telle
que la face de la piece) et non l'aréte.

Une fois que vous avez terminé de
sélectionner les références, utilisez ﬂ
I'icone Vue normale pour orienter

I'écran parallélement au support de
l'esquisse.

Piéce d'origine.

La contrainte créée
en vue normale
s'applique a l'aréte et
non a la face, comme
supposeé.

~ Faites pivoter le
modeéle pour veiller a
~ ce que la face
supérieure soit
... sélectionnée et non
I'aréte du congé.

Guide de I'étudiant
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Conseils concernant la géométrie d'origine (1/2)

Taille d'origine d'une esquisse :

+ Quand vous commencez a créer une 7

géométrie, essayez de la créer assez |

proche de la forme et de la taille de N

o | S

. . . . )
I'esquisse contrainte finale. Une esquisse -/

tres différente du contour requis sera | 7

déformée dés que les contraintes Esquisse
dimensionnelles finales seront appliquées. d'origine
Il sera difficile de contraindre entierement
l'esquisse.

=y

« Pensez a utiliser la grille pour vous aider a )
conserver une échelle correcte pour les R 28
éléments esquissés. ol A

D25

L'observation des valeurs dans la barre
d'outils Sketch tools (Outils d'esquisse) Esquisse
vous aidera a comprendre la taille réelle finale
des éléments que vous tracez.

Sketchtools K|

| ﬁ‘ i Ok t&| A <] End Point: H: [134.536mm i | -155.049mm L: | 19.738mm A: [222.812deq I

Guide de I'étudiant
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Conseils concernant la géométrie d'origine (2/2)

L'icone Contraintes géomeétriques (dans la
barre d'outils Sketch tools/Outils d'esquisse)
contréle si les contraintes géométriques sont
créées automatiquement ou non pendant le

développement de I'esquisse d'origine.

Cet outil est utile dans le cas d'une géométrie Sketchtools =
simple parce qu'il accélére la finalisation de la g %‘ ;:ZEQ;-O":;
forme. Alors qu'avec une géométrie plus
complexe, son utilisation peut entrainer la
création de contraintes indésirables.
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Conseils concernant la création de contraintes

Vous avez a votre disposition deux outils
pour définir des contraintes sur une esquisse,
comme montré ci-contre. Tous deux créent
des contraintes géométriques et
dimensionnelles.

En acquérant de I'expérience, vous verrez
qu'il est plus efficace d'utiliser le processus ci-
dessous pour créer des contraintes :

Double-cliquez
sur cette
ICONE.

=

En sélectionnant la géométrie vous

créez des contraintes dimensionnelles.

=i

Contraintes
géométriques

)

-

Contraintes
dimensionnelles

BReference

Swap Location

Sélectionnez la géométrie puis cliquez avec
le bouton droit de la souris pour créer des
contraintes géométriques.

Guide de I'étudiant
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Controle de la direction de contraintes dimensionnelles

Lors de la création d'une contrainte

dimensionnelle sur un contour, la direction de la

dimension est définie par le type d'élément

sélectionné. Si les éléments sont des points ou

des cercles, la direction par défaut de la /\ -
dimension est parallele a la droite qui relie les i -

points ou les centres des cercles.

Lors de la création d'une contrainte

dimensionnelle entre deux cercles ou deux points, .
vous pouvez forcer une direction pour la

dimension horizontale ou verticale en effectuant

un clic droit et en choisissant l'orientation requise.

Reference Reference

[ ] I 50 1
Horizontal Measure Direction 2|5 Hotizontal Maasure Direction b
wertical Measure Direction Wertical Measure Direction
Swap Location Swap Locakion
Coincidence Coincidence

Allow symmetry line Allow symmetry line

Paosition Dimension Position Dimension

2-69



Principes de base CATIA V5- Lecon 2 : Création de contours

Création d'une extrusion

Dans cette section, vous apprendrez a créer un composant de base simple. Apreés les
lecons suivantes, vos compétences dans le domaine de la création de composants
seront décupleées.

Suivez ces étapes :

5. Création de l'extrusion.

Guide de I'étudiant
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Finalisation du composant

Une fois que le contour esquissé a été créé, sa géométrie en solide 3D peut étre

génerée.

Contour 2D (esquisse)

=3 Partl
<=7 XY plane
<=7 ¥Z plane
== zX plane
r PartBody
=-cp)Pad.l
#- 7 Sketch 1

Extrusion

Guide de I'étudiant
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Utilisation d'une extrusion pour créer le premier composant

Suivez ces étapes pour créer une extrusion @
qui sera utilisée comme premier composant
d'un modele :

1. Sélectionnez I'esquisse du contour a utiliser
pour I'extrusion.

2. Cliquez sur l'icone Extrusion. @
3. Précisez la longueur. @

4. Terminez le composant.

aa Partl @

<=7 Xy plane
<=7 ¥z plane
<=7 zx plane
:-— PartBody
=-cpJPad.1
#-"7 Sketch.1
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Enregistrement et fermeture du document

Dans cette section, vous apprendrez a enregistrer et a fermer un modele.

Suivez ces étapes :

6. Enregistrement et
fermeture du document.
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Enregistrement de document

Vous devez enregistrer les documents pour que votre
travail ne soit pas perdu.

Il existe différents moyens d'enregistrer des
documents CATIA :

« Save (Enregistrer)

« Save As (Enregistrer sous)

« Save All (Enregistrer tout)

» Gestion des enregistrements

Les documents sont enregistrés :

» Aprés leur modification.
* Lors de la création de nouveaux documents.

Les documents peuvent étre enregistrés

+ Sous le méme nom (pour remplacer le document d'origine).

» Sous un nouveau nom (pour créer un nouveau document).

(XM Edit  “iew  |n=ert  Tc

D Mew... Chrl+r

@ Mew from...

(=% Ope Chil+0
Cloge

L] Sav Chl+5
Save bz
Save Al

Save Management. ..

Guide de I'étudiant
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Enregistrement d'un document sous le méme nom

Utilisez I'une des méthodes suivantes pour enregistrer une piéce sous le méme nom dans le méme
répertoire :

A. Cliquez sur File > Save (Fichier > Enregistrer).

B. Cliquez sur l'icdbne Enregistrer dans la barre d'outils
Standard.

C. Appuyez simultanément sur les touches <Ctrl> et <s>.

File Edit e Insert

| Mew.. Ctri+h i {B)-..
M frarm... i D %"\ p= - ;
ﬁ Qpen... Cirl+0 || Saves the act ument 3ave \
P 1 Save ]

Close

Save As..
Sawe All

Sawe Management..

Guide de I'étudiant
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Enregistrement d'un document avec un nouveau hom
Edit  Wiew Inser

La commande Save as (Enregistrer sous) B N
est utilisée pour enregistrer un document -

existant sous un nouveau nom. Elle crée une @Qp;n_, CHl+0
copie du document existant sous un nouveau e

nom ; elle ne supprime pas le document

d'origine.

Sawe All

Sawe Management..

La premiere fois que le document est
enregistré, CATIA ouvre la boite de dialogue
Enregistrer sous quel que soit I'outil utilisé
pour enregistrer le document.

p ot . Savers HEH|
our enregistrer une piéce sous un nouveau _ 7~ —
nom : Save i I _4 Models LZ) j ﬁl
|__limages
1. Cliquez sur File > Save As (Fichier > L) CATCOMFunPart CAT Part
Enregistrer sous).
2. A partir de la boite de dialogue Save as
(Enregistrer sous), naviguer jusqu'au
répertoire dans lequel vous voulez
enregistrer le fichier.
3. Spécifiez un nom pour le document. File name: | CATCOMFunPar_2.CATPart @ Save
4. Cliquez sur Save (Enregistrer). Save as lype: [CATPan - - |
Ici, le document est stocké
dans le méme dossier que le ™ Save as new document

document d'origine avec un
nouveau hom.
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Fermeture d'un document

Une fois que vous avez fini de travailler

avec le document, vous pouvez le fermer.

Suivez ces étapes pour fermer le

document :

1. Cliquez sur File > Close (Fichier >
Fermer) ou sur l'icbne Fermer.

2. Sivous avez fait des modifications mais
ne les avez pas enregistrées, une boite
de dialogue vous demande si vous voulez
enregistrer les modifications.

3. Vos options sont :

A. Cliquez sur Yes (Oui) pour
enregistrer les modifications.

B. Cliquez sur No (Non) pour fermer le
document sans enregistrer les
modifications.

C. Cliquez sur Cancel (Annuler) pour
garder le document ouvert.

2 LessonZcon..Part

[%]CATIA V5 - [L2_CS.CATPart] =[]
EJ Stat QEEW Edit  View Inset Took  Window  Help 8| x|
iy | Part [ Hew. Cilehd
Pard'y @ Mew from...
= Open.. Chrl+0 =
# P Save Chel+5 ™ @
Save bz - b
Save Al EI
S ave Management. .. @v
| e > y
= Erint.. Chl+F
. o i)
Frinter Setup...
Desk... @
Send To 4 iy I
| Document Properties B
J D 3 1L2_C5.CATP @v lé? J % EE ‘-9 e_‘”“
: art
Cloges the £ — EI |

@ Do pou want to save the changes you made to CATCOME*HouzingPanning ?

C

&
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Pour résumer

En utilisant les connaissances acquises pendant
cette legon, vous devez étre capable de créer la
plaque support.

La création de la plaque support nécessite :

v La création d'une nouvelle piece
La sélection du support d'esquisse adéquat
Le choix correct du contour

La sélection des contraintes appropriées pour
répondre aux besoins de la conception

La création d'une extrusion

L'enregistrement du modele sous un nom correct
et la fermeture du document

ANERNERN

AN
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Exercice : Contraintes d'une esquisse

Exercice : Recapitulatif

‘ 15 min

Dans cet exercice, vous créerez divers éléments géométriques dans l'atelier
Sketcher. Cet exercice vous aidera a comprendre comment contraindre et
dimensionner ces entités esquissées. Cet exercice est accompagne d'instructions
détaillées.

A la fin de cet exercice, vous serez capable de :

= Contraindre une esquisse
b 160 —
= Coter une esquisse
H
= Enregistrer et fermer un modele -} S
D50 NG
g5 K = \
B ?\
(%) o
" N\ y
! | i i N
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C'est a vous (1/10)

1. Créez une nouvelle piéece.

= Pour commencer le modelage, créez une
nouvelle piece et enregistrez-la en utilisant
l'option Enregistrer
a. Cliquez sur File> New (Fichier > Nouveau).
b. Sélectionnez Part dans la boite de dialogue

New (Nouveau).
c. Cliquez sur OK.
. Modifiez le nom de fichier en [Exercice_2d].
e. Cliguez sur OK. @
2. Ouvrez l'atelier Sketcher. 7
=1

= Les esquisses sont créées dans l'atelier
Sketcher. Vous pouvez y accéder en cliquant
sur l'icbne Positioned Sketch (Esquisse
positionnée).
a. Sélectionnez XY Plane (Plan XY) comme
support d'esquisse.
b. Sélectionnez Part origin (Origine de la
piéce) comme piéce.
c. Sélectionnez Y Axis (Axe Y) comme
orientation.

® ®6

Guide de I'étudiant
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C'est a vous (2/10)

3. Activation de I'option Contraintes automatiques

Dans I'exercice précédent vous avez désactiveé
l'option Contraintes pour vous concentrer sur
l'utilisation des outils d'esquisse. Par défaut, les
icbnes Contraintes géométriques et Contraintes
dimensionnelles sont activées.

a. Assurez-vous que les icones Geometrical
Constraints (Contraintes géométriques) et
Dimensional Constraints (Contraintes
dimensionnelles) sont en surbrillance. Si elles
ne le sont pas, cliquez sur les icones pour activer
les options.

4. Tracez un contour.
Pour commencer l'esquisse, créez un contour en

utilisant I'outil Contour pour définir la forme et la
taille générales de I'esquisse finale.

a. Cliquez sur l'icbne Contour.
Définissez un point pour établir le point du départ.
Tracez une droite horizontale.

Cliquez sur l'icone Arc tangent.

Créez l'arc illustré ci-contre.

L'outil de contour retournera vers |'option par
défaut Droite. Créez une autre droite horizontale.

Créez la droite verticale. @m[m
Créez la troisieme droite horizontale.

~ o a0

= Q@

] %‘ % b| Ve O O End Paint: H: [268.585mm

Guide de I'étudiant

m
R

Assurez-vous que les icones Contraintes
géométriques et Contraintes
dimensionnelles sont en surbrillance,
comme montré ci-dessus.

. [22.220mm L [232.007rm A:[163.301deg

i. Complétez le contour en ajoutant une droite qui
joint le point de départ du contour.
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C'est a vous (3/10)

5. Créez des dimensions horizontales @
générales. [ 1]

= (Créez toutes les dimensions
horizontales pour le contour en utilisant

-

(50)
(5b)

c. Faites glisser la souris pour
positionner la cote. Cliquez pour
terminer la cote.

d. Cliquez deux fois sur la cote.

e. Modifiez la valeur en [340].

f. Cliquez sur OK pour fermer la boite ramEEN

de dialogue et mettre a jour la cote.

i

1] @

I'outil Contraintes. r H
a. Cliquez sur l'icbne Contrainte. =
b. Sélectionnez le segment de droite. :
—_ H
|

-
L1
=

Guide de I'étudiant
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C'est a vous (4/10)

6. Créez une cote de diametre.

= Mesurez l'arc en utilisant I'outil de
contraintes et modifiez le type de cote en
Diametre.

a.

Cliquez sur l'icbne Contrainte.

b. Sélectionnez l'arc.

c. Faites glisser la souris pour positionner
la cote. Cliquez pour terminer la cote.

d. Double-cliquez sur la valeur et modifiez-
la
en [25].

e. Cliquez sur le menu Dimension
(Cotation) et modifiez l'option de Radius
(Rayon) en Diameter (Diamétre).

f.  Cliquez sur OK pour mettre a jour la
cote.

Conztraint Defimon 2] x|
Fadius |25|T|m E [ Reference
i A
o
Dimensionf g - die jGe’
M e |
- @ 0Ok I - Eancell

! - 340

R 16 0849
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C'est a vous (5/10)
7. Créez une cote verticale. Eﬁ

=  (Créez toutes les cotes verticales du -
contour en utilisant I'outil de contraintes.

a. Cliquez sur l'icbne Contrainte.
b. Sélectionnez la droite horizontale

supérieure.
c. Sélectionnez la droite horizontale
inférieure. a
criedre | [
d. Faites glisser la souris pour ' '
positionner la cote et cliquez pour la
terminer.
e. Double-cliquez sur la mesure et " "
entrez [85]. PR
100 H._I
— ) »
Constraint Definition K == * 1
S~
VaIuEIEEmm ‘ 7e » = [ Reference
B 2] H
=) @ v
More»l T bep
] < Eancell @
H

- |

2-84



Principes de base CATIA V5- Lecon 2 : Création de contours

Guide de I'étudiant

' by
C'est a vous (6/10)
8. Créez une cote horizontale. ﬁl
= Créez la cote horizontale en utilisant v
I'outil Contrainte.
a. Cliquez sur l'icbne Contrainte. S
s . . ¥ 0
b. Sélectionnez la droite horizontale pgn @
supérieure. 85
c. Faites glisser la souris pour AN .
positionner la cote et cliquez pour ] —‘
terminer son positionnement. . - 54 |

d. Cliquez deux fois sur la cote et
modifiez sa valeur en [100].

340
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C'est a vous (7/10)

9. Créez une cote d'angle.

= Créez une cote angulaire entre la
droite horizontale inférieure et la
droite adjacente en utilisant I'outil
de contrainte.

a.
b.
C.

Cliquez sur l'icéne Contrainte.

Sélectionnez la droite d'angle.

Sélectionnez la droite
horizontale inférieure.

Positionnez la cote.

Modifiez la valeur angulaire en
[30] degrés.

Guide de I'étudiant
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C'est a vous (8/10)

10. Créez une contrainte horizontale.

= Appliquez une contrainte horizontale a
la droite en utilisant I'outil Contrainte
Boite.

a. Sélectionnez la droite horizontale.

b. Cliquez sur l'icéne Contrainte
choisie dans une boite de dialogue

c. Sélectionnez I'option Horizontal
(Horizontalité) dans la boite de
dialogue Constraint Definition
(Edition de contrainte).

d. Cliguez sur OK pour appliquer la
contrainte a I'esquisse.

%WD%‘
H

D50

R 00 s

10a
e
H
_T : 340 {
%I Constraint Definition ElE3
[ Distance [ Fix
[ Length [ Caincidence
[ sngle [ Cancentricity

[ Radiuz / Diameter [ Tangency
[ Semimajor asis 1 Paralielism
[ Semiminar asiz [ Perpendicular
[ Symmetry “ Harizantal (10c
[ Midpaint [ ertical

[ Equidistant pnih Od)
Nor

@ Ok I iEanceII
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C'est a vous (9/10)

11. Créez un cercle et contraignez-le.

= Créez un cercle en utilisant I'outil
Cercle. Contraignez son centre avec
I'arc en utilisant I'outil Contrainte Boite.

a. Tracez un cercle.

b. Sélectionnez le point centre de l'arc.
Appuyez et maintenez enfoncée la
touche <Ctrl> et sélectionnez le

centre du cercle.

c. Cliquez sur l'icéne Contrainte
choisie dans une boite de dialogue.

d. Sélectionnez I'option Coincidence

(Coincidence).

e. Cliquez sur OK pour appliquer la

contrainte.

[ Length 4 Coincidence
[ &ngle [ Concentricity
[ Radiuz / Diameter [ Tangency
[ Semimajor axis [1 Parallelizm
[ Semiminar axis [1 Perpendicular
[ S pmmetey [ Horizarital

[ Midpoint @ ertical

[ E quidistant point

Constraint Definition K E3
[ Distance I Fix Q1

@ 0Ok I ﬂl:anc:ell

Sélectionnez les points centres
de l'arc et du cercle.

S
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C'est a vous (10/10)

12. Vérifiez la contrainte de coincidence.

= Déplacez le centre du cercle et assurez-
vous qu'il ne peut pas se déplacer tout
seul. Si le cercle peut se déplacer sans

déplacer l'esquisse complete, cela
signifie que l'esquisse n'est pas
contrainte correctement.

a. Sélectionnez le centre de l'arc et du

cercle.

b. Appuyez et maintenez enfoncé le
bouton gauche de la souris, essayez
de déplacer le point vers la droite ou
la gauche. L'esquisse compléete doit
se déplacer.

c. Sélectionnez le type de contrainte
Coincidence et appuyez sur la
touche <Supprimers.

d. Sélectionnez le centre du cercle et
essayez de le déplacer. Seul le cercle

doit se déplacer.
e. Supprimez le cercle esquissé.
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Guide de I'étudiant

Récapitulatif de I'exercice : Contraintes d'une esquisse

v' Contraindre une esquisse

v' Coter une esquisse
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Exercice : Contraintes d'une esquisse

Exercice : Recapitulatif

‘ 15 min

Dans cet exercice, vous contraindrez totalement une esquisse existante en utilisant
les outils de I'exercice précédent. Cet exercice vous aidera a comprendre comment
contraindre et mesurer des entités esquissées. Cet exercice est accompagné
d'instructions de haut niveau.

A la fin de cet exercice, vous serez capable de :

Charger un document existant
Contraindre une esquisse
Coter une esquisse

Utiliser des compétences de
résolution de probleme

Enregistrer et fermer un modele

ATTENTION : D'une maniere générale, pour les piéces complexes, il est préférable de simplifier les esquisses
en utilisant des composants 3D dédiés tels que des congés, des chanfreins, des trous, des dépouilles, etc.,
afin de mieux répondre aux objectifs de conception et de fabrication.
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Etude de cas : Création de contours

Exercice : Recapitulatif

‘ 10 min

Vous allez mettre en pratique ce que vous avez appris en réalisant le modéle
de l'étude de cas : seul un dessin détaillé vous servira de guide.

Dans cet exercice vous créerez le modéle de I'étude de cas. Gardez en
meémoire l'objectif de conception du modéle :

v Le modele doit étre créé comme un composant unique.

v Le modele doit étre centré par rapport aux plans YZ et ZX.
v" Les petits trous doivent étre a 30 mm du trou central.

v" Le trou central doit rester au centre du support.

v Le modeéle doit étre enregistré sous le nom Support_Plaque.

Utilisez les techniques précédemment abordées
pour créer le modele sans les instructions
détaillées.
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C'est a vous : Dessin de la plaque support

-
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Etude de cas : Plaque support (récapitulatif)

v" Créez un fichier piéce.

v Sélectionnez le plan YZ comme support
d'esquisse.

v' Créez une géométrie d'esquisse.

v Imposez des contraintes a I'esquisse selon
I'objectif de la conception. 2

v" Créez une extrusion. -

v Enregistrez et fermez le document. Il ;/3\ o '

o | Fart1
L7y plane
&7z plane
77 zx plane
= {83 PartBody
S-pfbadl
#=4 Sketon 1

- Ve

— He =
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